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ORGANIZING YOUR PHOTOS
INTO LIGHTROOM COLLECTIONS

Lesson overview

This lesson covers how to sort through your images to separate the
ones that are keepers (that you will print, share, or put in your port-
folio) and ones you can discard or review later. You'll start by going
through a specific workflow for culling images using flags in Adobe
Photoshop Lightroom Classic, and walk through the process of sort-
ing those images into discrete collections. From there, you'll learn
how to set up a hierarchical structure using collection sets.

In this lesson, you'll learn how to:

e Employ color labels in your image.

e Use a star system to rank your images.

 Filter images based on flags, colors, or other metadata.
e Set up smart collections for specialized tasks.

e Setup a target collection for quick organization.

e Share and get feedback about your published online collections.

This lesson will take about 1% hours to complete. To get the lesson files
used in this chapter, download them from the web page for this book at
adobepress.com/PhotoshopLightroomCIB2022. For more information, see
“Accessing the lesson files and Web Edition” in the Getting Started section
at the beginning of this book.


http://adobepress.com/PhotoshopLightroomCIB2022

The Lightroom Library module makes it easy to assess and
manage your ever-growing image catalog.




Preparing for this lesson

Before diving into the content of this lesson, make sure you do the following:

1 Follow the instructions in the Getting Started section at the beginning of this
book for setting up an LPCIB folder on your computer, downloading the lesson
files to that folder, and creating an LPCIB catalog in Lightroom.

2 Download the Lesson 02 folder from your Account page at adobepress.com to
username/Documents/LPCIB/Lessons.

3 Launch Lightroom, and open the LPCIB catalog you created by choosing File >
Open Catalog and navigating to it. Alternatively, you can choose File > Open
Recent > LPCIB Catalog.

4 Add the Lesson 2 files to the LPCIB catalog using the steps in the Lesson 1 section
“Importing photos from a hard drive” Lightroom may ask if you want to enable
address lookup. You can dismiss this notification.

Iterative culling: My workflow

The single most tedious task after a photo shoot is sorting bad pictures from good
so that you can come up with a plan for editing. This process is known as culling
and is one of the most important steps you can do in Lightroom.

I spend a lot of time talking to people around the world about their use of Lightroom,
and this seems to be the part of the process people struggle with the most. To fix that,
I want to share the technique I use when working with my photos. This is something
I learned a long time ago, back in my days as a high school teacher, and I call it the
“iterative edit”

If you have to take a timed test of multiple choice questions, the best strategy for
completing it is to go through the test as fast as you can, answering all the questions
that you know you have correct. When you get to a question that you do not know
the answer to, the strategy is to skip it. By doing this, you can quickly complete the
answers you do know, leaving you more time to work on the ones you don’t and
allowing you to pick up context clues from your completed answers.

Now, let’s apply this idea to our photography. If a shoot contains 200 pictures, there
is a good chance that a large number of those pictures are either really good or really
bad. By “bad” I mean things like: out of focus, the eyes are closed in a portrait, or you
cut off someone’s head. These are things that we immediately know are problems, and
we would never spend any time working on these images. Conversely, with the good
pictures, we're not trying to pick the very best picture out of the very best series.
We're looking for pictures that are okay: it’s exposed, it’s composed, it has the subject.
Ranking them is something we’ll do later.
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Adding flag markers in Lightroom

Let’s begin by going into the Lesson 01 folder in the Library module’s Folders panel
in Lightroom. This shows a grid of images that we can start culling. As we learned
in the previous lesson, we can get rid of the panels on all four sides by pressing Shift+
Tab. We can also black out the interface by pressing the L key twice to go into Lights
Out mode. This will get rid of all of the distractions in the Lightroom interface that

take us away from doing the job at hand—culling.

You have a couple of options with each image. If it is a picture that you think is
worth keeping, press P on the keyboard to mark it as a pick. If you believe the pic-
ture is completely off, press X to mark it as rejected.

If you have to think for more than half a second about whether this picture is effec-
tive, press the Right Arrow key on the keyboard to skip the picture and go on to the
next one. Remember your qualifications for bad and good. Do not spend more than
a second thinking through these pictures. The goal is to get rid of the pictures that
you know will not work.

If you click one of the flags and the picture doesn’t advance, choose Photo > Auto
Advance. Should you mistakenly add the wrong flag to one of the pictures, press
the Left Arrow key to go back to the picture in question, and then press the U key.
Pressing U unflags the picture.

Once you finish this process, you should have your pictures sorted into three
different types of images: those that you know won’t work (the bad images), those
that you want to consider for ranking, and those that you have not gone through
yet. Lightroom has a way to filter all of these pictures: the Library Filter bar at the
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top of the center preview area. The Library Filter bar has the following options to
help you find specific images:

e Text mode allows you to filter your Lightroom catalog for specific words. These
words can be in the filename, title, caption, or any of the metadata embedded in
the image.

e Attribute mode lets you filter out images based on flag status, star rating, color
label, or virtual copy status, as shown below.

Atiribute

e Metadata mode lets you sort your images using a host of different metadata
items Lightroom has compiled from your images. This is an extremely powerful
way of filtering, but outside the scope of this book.

Click the Attribute tab, then select one of the Flag options (pick, unflagged, or
rejected) to see only those specific images appear in the preview area. The filter icons
are not exclusive—you don’t have to select only Reject flags or Pick flags. If you click
both in the Attribute filter, Lightroom shows you both sets of images in Grid view.

At the top right of the Filmstrip panel, there are similar Filter options (if you don’t

see the flag icons next to the Filter menu, choose Flagged from the menu). At the
top left of the Filmstrip panel, you see the number of images in that folder or collec-
tion that contain a specific flag.
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At this point, the images that are the most important part of the process are the
unflagged ones. Click the Unflagged Photos Only icon, hide the panels (press Shift+
Tab), go into Lights Out mode (press L twice), and repeat the culling process until
nothing appears in the preview area.

You will notice that this second iteration of culling goes much faster than the first

one. The best thing about this part of the process is that you now have seen the
shoot in its entirety, and can make better judgments as to which pictures stay and
which pictures go. The only part you'll find disconcerting is the end—when you get
to a completely black screen. Don’t worry; just turn the lights back on (press L) and
bring back the panels (Shift+Tab). You'll notice the screen was black because there
were no more unflagged images. Click the Unflagged Photos Only icon again to
bring back all your photos, and your cull is complete!

What is a collection?

As your Lightroom library gets bigger and bigger, you'll need to have key images

in your catalog accessible for various purposes. As mentioned, prior to Lightroom,
photographers who wanted to share a group of images, like a portfolio of portraits,
often placed copies of those pictures in a folder to share. As different needs arose,
they had to create other folders and store more copies of the same pictures in them.
Each folder had a specific need and contained copies of pictures that also lived in
other folders. Keeping track of the copies, and the space they occupy, makes this
solution untenable. This is where collections save the day.

If you're familiar with buying digital music, you can think of Lightroom collections

as playlists for your pictures. You purchase one song and own one physical copy of a
song, but that song can live in an unlimited number of playlists. The same holds true
for pictures and collections in Lightroom.

On the left side of the Library
module, you have a Collections
panel. Click the plus sign (+)
in the panel header, choose
Create Collection, and give

Create Smart Cdluk\..
Create Collection Set...

the collection a name. From
Sort by Hame

there, you can add images from v Sort by Kind

 Show Collection Filter

throughout your catalog to the

Note: Some
Lightroom users
prefer to maintain
multiple catalogs to
separate personal and
professional images. If
you're an experienced
Lightroom jockey, that
may work well for you.
However, because
the Lightroom search
features work on one
catalog at a time, you
may find it easier to
maintain a single
catalog.
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collection, no matter what folder they live in, and you can add as many collections
as you need for organization.

Every collection that you create in Lightroom can hold images from any folder you
have imported into your catalog. It doesn’t matter if the images live on your hard
drive, an external drive, or a network-attached storage drive. The Lightroom catalog
(your digital notebook) notes that you have one physical file but would like to have
a reference to that file in multiple collections. The collections serve as a way to look
at disparate parts of your photographic life without having to change your folders or
make copies of your photos to live in different folders. This is an extremely powerful
feature and one that your photographic life will revolve around.

In an effort to show you this concept in its simplest form, I'll share with you a series
of photos of my daughter, Sabine, and my wife, Jennifer.

Creating collections from folders of images

Let’s experiment with creating collections and adding images to them with the files
that we've imported for Lesson 2.

1 Go to the Folders panel in the Library module and click the little triangle to the
left of the Lesson 02 folder. Inside that folder, you'll see a series of folders that
we’ll make into collections.

2 Right-click one of the folders that contains the word Sabine in the name, and
select Create Collection “folder name” from the menu.

3 Repeat this with all of the other folders that have the word Sabine in their names,
making collections for each of them. When you’re done, you should have a total
of six collections.

4 Press Command+D/Ctrl+D to deselect
all photos. Click the plus sign (+) on the
right side of the Collections panel’s header,
and create two additional collections: Best
Holiday Moments and Cute Sabine Pictures,
as you see here on the right.
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5 While it might seem repetitive to have collections that are named exactly like
your folders, there are a couple of really powerful things happening under the
hood here. First, unlike in a folder, you can drag the images around within the
preview area and sort them into whatever order you like.

Second, you have the option to add images from any of those Sabine collections
to the Best Holiday Moments or Cute Sabine Pictures collections. It doesn’t
matter where those images live or what folders they are in, you can simply drag
any of them into a new collection if you'd like. The catalog (your digital notebook)
will still reference that one physical file.

To show you the third important part about collections, click the thumbnail of
the first picture in the 20211031-sabine-pumpkin and drag it into both the Best
Holiday Moments and Cute Sabine Pictures collections.

6 Although we haven’t covered developing a picture yet, let’s make a quick change
to this photo. On the right side of the Library module, open the Quick Develop
panel’s Tone Control section. Under Exposure, click the double left arrow three
times. This should darken the image by three stops. You will see the change in
the image in this collection immediately.

R
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The awesome part about

this is that the thumbnails

of this image in the other

two collections also will
change to reflect the darker
picture. You don't have to
remember where the physical

picture lives; Lightroom
automatically makes that
change across all instances of the image by referencing that one physical file.

Before we go any further, let’s create collections for the rest of the folders in the
Lesson 02 folder (all of the folders with the word Jenn in them). You should then
have a total of 17 collections.

Creating collection sets

It’s easy to see that our list of collections could get a little unwieldy. With so many
Sabine collections, it would be hard to scroll and visually see where my work images
are versus my family images. That said, there is a common element that runs through
all of these collections of Sabine: my daughter, Sabine.

1 Click the plus sign (+) on the right side of the Collections panel’s header, and
select Create Collection Set. In the Create Collection Set dialog box, create a set
called Sabine Images, and make sure the Inside A Collection Set check box in
the Location area is unselected. Once the collection set is created, drag all of the
Sabine collections into the Sabine Images collection set.

Create Collection...
Create Smart Collection...

Sort by Name
v Sort by Kind

The result is a much cleaner look Greate Collection Set
to the Collections panel. If you

MName: Sabine Images

want to see the pictures inside all s vm——

the Sabine collections, just click

the Sabine Images collection set. concel (ST
If you want to see pictures from ‘

one of the individual collections,

click that individual collection.
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2 We can take this a step further. The Jenn collections also could benefit from that
type of grouping. Create a collection set called Jenn Images, and make sure the
Inside A Collection Set check box is unselected. Then, drag all the Jenn collections
inside the Jenn Images collection set. This makes our collections even cleaner.

3 We can still take this level of organization further. Another great benefit of the
collection set is that it holds not only collections but other collection sets as
well. Looking at the collections that you have here, are there any other common
elements that we can group around? Jenn and Sabine are my family. We could
theoretically create a collection set called Family Images and place both the
Sabine Images and Jenn Images collection sets in it.
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Then, should we want to see all the family images, we could click the Family Images
collection set. If we want to see a series of Jenn images, we can click the Jenn Images
collection set. If we want to see Sabine images, we can click the Sabine Images col-
lection set. To see individual events, we can click the individual collections to drill
down further. In other words, a place for everything, and everything in its place.

Sample organizational sets

Now that we know that our collections can be used to see a subset of pictures across
our catalog and that collection sets can let us organize all of those views, let’s put it
into other workflows that make sense.

Let’s say I work doing people photography, and I get an assignment to make a series
of pictures of my friend Latanya Henry. In that shoot, I would have several groups

of pictures—picked images to go over, rejected images, images that I want to edit
further, images to take into a slideshow, and so on. If I made a collection for each
group, what would happen if I got hired again to make another series of pictures for
Latanya? Would I just create “Latanya Picked Images Number 2” and name the other
collections in the same manner? That would be too messy.

Instead, what if we made a collection
set for Latanya Henry? Then, when
Iimport the first shoot with Latanya,
I would make a collection set for that
specific shoot. Inside it, [ would place
all the collections that are related to
that shoot.

The next time I shoot with Latanya,
I'would create a collection set for
that second shoot, and repeat the
process. Not only does this allow you
to see only what you want to see, but
it also lets you separate out individual

images for the other functions in Lightroom, such as books or slideshows. You can
have a collection for each function.

On the next page are a series of sample suggestions that you can use to organize your
photography work. If you are a wedding photographer, you can use collection sets
on a per couple basis, with a collection set for each couple’s wedding. Inside each
wedding, you can separate production work (shots from multiple cameras) and the
finished work, using collections to sort out the various pieces of the wedding.

If you are a commercial photographer who does multi-day shoots, you can make
a collection set for the entire job, organize the days into individual collection sets,
and filter out the best shots into a “best of” collection. If you are a landscape pho-
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tographer, the organization would be similar to that of a commercial shoot, but
instead of jobs, you can sort by locations.

These samples are provided as ideas to get you going, not as hard-and-fast rules for
your photography work. The point is that you should take a moment to plan how you
want to organize your Lightroom catalog using collections and collection sets. Once
you do, it’s up to you to stick to that format. It’s a little time-consuming at first, but it
pays great dividends later on as your catalog gets larger.

What is a smart collection?

Smart collections are collections
that you build based on pre- 2

defined criteria. Click the plus - Callection Set...
sign (+) on the right side of the . CSortbyName
Collections panel’s header, and ' o i
choose Create Smart Collection

' Show Collection Filter

from the menu.

In the Create Smart Collection dialog box, you can pick from a ton of different cri-
teria to pull images into your smart collection. Below the Match menu, the left side
shows you the criterion chosen, the center section gives you comparison options,

and the right side gives you the restrictions for each criterion. Click the plus sign (+)
at the upper right of the rules field to add another criterion (you can have as many

as you want).

Once the smart collection has been created, you will see it in the Collections panel
with a number of images in it. The number of images in a collection increases or
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decreases as you flag images across your entire catalog. In this example, I created a
smart collection that will keep track of images that I mark as rejected. As I flag my
images, no matter where in the catalog the rejected ones live, Lightroom will keep a
running tally of them inside this smart collection.

L] Create Smart Collection
Name: Rejected Images

Location

Inside a Collection Set

Match  al B8 of the following rules: flagged
unflagged
Pick Flag % is E  rejacted % ) =

I recommend that you drill down into that column on the left during your smart
collection creation. You'll find a ton of parameters that you can immediately put to
use in sorting your photographic work.

What is the Quick Collection?

There may be times when you don’t necessarily need to create a collection, but
would like to temporarily organize

a set of images into a group. Rather
than creating and deleting a regular
collection, moving images around,
or exporting images unnecessarily,
you can use the Quick Collection.
The Quick Collection does not live in
the Collections panel and is available
to you by clicking Quick Collection
in the Catalog panel or pressing
Command+B/Ctrl+B.

Add images to the Quick Collection as you move about the Library module by
selecting an image and pressing the B key. Or, in Grid view, click the small Quick
Collection circle in the upper right of any thumbnail; it turns gray to show you that
the photo has been added to the Quick Collection.

What is a target collection?

A target collection takes all the ease of adding images to the Quick Collection,
and following the same process, assigns the images to one of the regular collections
you've created. To use this feature, right-click a collection you've already created
and choose Set As Target Collection (you'll see a plus sign [+] appear to the right
of your collection name). Now, every time you press the B key, the selected image
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will be added to the
target collection you
specified, and not to
the Quick Collection.
To turn the target col-
lection off, right-click
it in the Collections
panel and choose Set
Target Collection from
the menu again. Then,

the images will go
back to being added
to the Quick Collection.

Sharing your collections online

Another benefit of having your images in collections is that you can share the col-
lections online. Previously, if you needed to get feedback on a shoot from someone
else (a client, family members, friends), you would have to export images from the
collection and import them into a third-party website.

In Lightroom Classic (desktop), you can automatically sync a collection with
Lightroom (mobile) once you turn syncing on. Click the cloud icon at the right of
the Module Picker and click Start Syncing. Then, select the Sync With Lightroom
option in the Create Collection dialog box. If you forget to do this when creating
your collection or decide to sync it later, simply click the lightning bolt icon to the
left of the collection name. Lightroom Classic will generate the files and automati-
cally create an album in Lightroom, as well as a private website you can view by
logging in at lightroom.adobe.com. You can make the gallery public by clicking the
Make Public button in the upper-right corner of the preview area.

After you click Make Public, Lightroom Classic creates a URL that you can share

with others (to the left of the button you clicked to make the website public, once
you have made it public). In the online version of Lightroom (which has fewer
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features than Lightroom Classic), all flags, star ratings, color labels, and other meta-

data settings will appear with the images (as you can see in Grid view below).

After clicking a thumbnail,
you are taken to Loupe view,
where you can click the

Info icon to see the photo’s
metadata or the Activity icon
to leave a comment or read
other viewers’ comments.
Those comments are auto-
matically saved to the cloud

and then synced back to your
computer for you to review
in the Comments panel (which appears below the Metadata panel in Lightroom
Classic once a collection is made public).

Adding star ratings and color labels

Rating your images is pretty simple. Pressing the numbers 1-5 will add one to five
stars to any images you have selected. To remove any of the star ratings, just select
the image and press the number 0.

In addition to pressing 1-5 for star ratings, pressing the numbers 6, 7, 8, and 9 on
your keyboard will add the red, yellow, green, and blue colors labels, respectively.
There is one color left—purple—that can only be accessed through the Photo > Set
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Color Label menu. To remove the color from an individual picture, just select the

photo and press the number for the associated color again, and the color is gone.

Now that you know how to add star ratings and colors to your pictures, let’s talk
about how best to use them. Once your pick and rejected flags have been assigned,
you can use star ratings to rank your pictures in a “good, better, best” scenario.

The star rating system also can be useful for marking images for specific tasks or cat-
egories. Your portfolio shots can have five stars, while images that go into a slideshow
can be your four-star shots. Or, in a wedding shoot, images of the groom’s family can
have three stars, while images of the bride’s family can be your two-star shots.

I like to use colors for files that I am going to work on in Photoshop, files that are
ready for printing, and final edits of files. Any red-labeled images in my catalog are
images that need some work in Photoshop. The green-labeled images are ready for
printing. Purple-labeled images are final copies of images that need no additional
editing. I use purple for final images, as it’s the only color that I cannot accidentally
select with a number key. The colors also make it very easy to spot images that need
to be worked on while in Grid view.

Adding keywords

Adding keywords is an extremely powerful way to keep track of photos by subject
matter in your Lightroom catalog. Think of them as search terms, like the ones you
use to find something on the web. Keywords don’t take up much space—they’re text
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added to the photo’s metadata—so you can apply as many keywords to each photo
as you want.

For the best results, make your keywords descriptive of the subject matter, such as
“diving,” “snorkel,” “underwater,” “freedive;” and so on. Avoid adding keywords that
you've included in the photo’s filename, because the Lightroom search capability

extends to filenames, too.

You'll develop your own list of keywords as you go, but to get you started, use the
following steps to add keywords to the exercise files:

1 In the Library module, go to the Collections panel, and make sure that you have
the 20180725-jenn-diving collection selected. We will add some keywords here.

2 In the Grid view, select a series of images from this collection (click the first
photo you want to select, then Shift-click the last image to select all the images
in between).

Tip: To create 3 Inthe Keyword List panel on the right, click the plus sign (+) on the left side of
nested keywords, the panel’s header. In the dialog box that appears, enter Botella in the Keyword
select an existing
keyword in the
Keyword List panel field (use a comma to separate the synonyms). Select the Add To Selected Photos

Name field, and then type Snorkeling, Underwater, and Whale in the Synonyms

and then click the option, leave the three export options selected, and then click Create.
plus sign (+) to add
another keyword.
To see nested
keywords, click

the triangle to the
left of a keyword

in the Keyword List
panel to expand
your keyword
hierarchies. You
canalso type a
keyword into the
search field at the
top of the Keyword
List panel to reveal
itin the panel.

P
Create Keyword Tag

Keyword Mame: Botella

Synonyms: | Snorkeling, Underwater, Whale@

Keyword Tag Options

Include on Export

Export Containing Keywords
Export Synonyms

Person

Creation Options

Add to selected photos

Your new “Botella” keyword appears in the Keyword List panel, and Lightroom
adds it to the selected photos. A general keyword like this also can serve as a
category in which to nest more specific keywords (say, “freedive” and “scuba”).

4 Now, select the last four images and repeat step 3, creating the keyword
Snorkeling and applying it to your selected photos.

5 To see all the photos in your Lightroom catalog that have a specific keyword,
move your pointer over the number to the right of that keyword in the Keyword
List panel and click the arrow that appears to the number’s right.
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When you click the
arrow to the right of
a keyword (circled),
Lightroom auto-
matically switches
your source to All
Photographs in the
Catalog panel. Once

appears in its lower-
right corner.

Other ways to apply (and delete) keywords

As you may imagine, there are additional ways to apply keywords. For example,
you can:

e Dragand drop the keyword from the Keyword List panel onto one or multiple
selected thumbnail previews.

e Dragand drop one or more selected thumbnails onto a keyword in the Keyword
List panel.

e Select one or more thumbnails, and in the Keyword List panel, select the check
box that appears to the left of a keyword. To remove a keyword from a photo, do
the same thing but deselect the check box that appears to its left.

e Use the Keywording panel (it’s above the Keyword List panel). If you go this
route, you can create and apply keywords in the same step. To do this, select
some thumbnails and then click within the box labeled “Click here to add
keywords.” Enter a new keyword. If you want to create and apply more than
one keyword to the selected photos, use a comma between each keyword. For
example, you may enter Dune, Desert and then press Enter/Return on your
keyboard to create and apply both keywords.

To delete a keyword from your list, use the Keyword List panel (not the Keywording
panel). Click the keyword and then click the minus sign (—) on the left side of the
panel’s header. In the warning dialog box that appears, click Delete.

Alternatively, right-click the keyword, and from the menu that appears, choose
Delete. In the warning dialog box, click Delete. In fact, the aforementioned menu
offers several useful options for managing your keywords. For example, you can edit
them, remove a keyword from the selected photo, or delete the keyword altogether.

Either way, the keyword is removed from your keyword list and from any photos
you applied it to.
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Review questions

1 What'’s the simplest way to assess and cull recently imported photos?
Name three reasons it is important to use collections.

What is a smart collection?

What is the Quick Collection?

How do you share a collection online publicly?

How do you add a five-star rating to a photo?

N & unn A W N

How do you create a new keyword in the Keyword List panel?
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Review answers

1 Use the Pick and Reject flags to assess and cull imported photos.

2 First, you can drag images in a collection into any order you want. Second, you can add
a photo to as many collections as you want without making a new copy of the photo
(saving you disk space). Third, any Develop changes you make to the image will be
reflected in each collection it is in.

3 A smart collection is a self-populating album based on criteria that you set.
4 The Quick Collection is a temporary collection that lives in the Catalog panel.

5 Click the lightning bolt icon to the left of the collection name in the Collections panel,
then click the Make Public button at the upper right of the preview area.

6 Press the number 5 key on your keyboard.

7 Click the plus sign (+) on the left side of the Keyword List panel’s header.
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INDEX

INDEX

A

add, 21
adding detail, 80-85
adding masks, 114-115
adjustments. See also editing
auto, 72,73
filter, 101
global, 9, 67-85
linear, 99-102
local, 9, 94-131
multiple, 104
Photoshop-specific, 11
Radial Gradient tool, 103—-104
relative vs. absolute, 34
shadows and highlights, 73-77
viewed side by side, 125-127
whites and blacks, 77-79
Adobe Authorized Training Centers, 15
Adobe Photoshop Classroom in a Book, 2
Adobe Photoshop Elements, 154, 156
Adobe Photoshop Lightroom Classic Classroom
in a Book, 2,316
Adobe Photoshop Restoration & Retouching
(Eismann, Palmer, Dunbar), 230
Adobe Raw profiles, 70
Adobe RGB, 151, 152
Adobe Sensei, 97
Al (artificial intelligence) masks
additions/subtractions, 187-190
Adobe Sensei, 97
new masks via, 98
Photoshop tools for, 159-162
Select Subject, 110
Allen, Will, 195
alterations, 11
angled selections, 184—187
anorexia, 231
Attribute mode, 48
Auto Sync, 92

B

backgrounds
correcting portrait, 201-202
Select And Mask workspace, 196

backups, 18
Balance slider, 123
base color, 274
beauty, manufacturing, 231
bit depth, 9, 153
black-and-white effects, 120, 126—-127
Blacks, adjusting, 77-79
blemish removal, 116-118, 140, 226227
blending
automatic, 211, 212
color, 274
layer blend modes, 274
photo combinations and, 269
signature graphic, 302
Blending slider, 123
blocked areas, 73
blown out areas, 73
blur effects, 250-258
Blurb.com, 315
body sculpting, 225-230
bokeh, 253
books, 10, 312-315
Boundary Warp, 289
bracketing feature, 284—285
brightness, 72, 114
Brush tool. See Masking Brush tool
brushes, mixing with, 245
Build Previews, 29

C

Camera Matching profiles, 70
camera profiles, 68
Camera Raw
installation of, 2
skin texture filter, 228—229
snapshot information, 172, 173
synced with Lightroom, 157-158
Candidate photo, 37
canvas extension, 260-261
catalogs
emailing from, 301
exporting from, 303
how to create, 12-13
importing to, 20-30
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information in, 6
single vs. multiple, 20, 49
changes, syncing, 90-92
chromatic abberation, 86
cinematic color grading, 69
circular adjustments, 103
Clarity, 79-80, 113, 287
Classroom in a Book series, 1-2
Clear slider, 241
Clone Stamp tool, 212-213
cloning, 159, 163, 164
CMYK workspace, 152
collages, 269-281
collections
collection sets, 52—54, 162
creating, 50-52
defined, 49-50
Library module, 33
Lightroom, 7
organizational sets, 54—55
Quick Collection, 56
sharing, 57-58
Smart collections, 55—-56
target, 32, 5657
color
cast, 78
converted to black-and-white, 120-122
creative effects, 120-127
fading gradient, 275
first edit for, 180
grading, 69, 122-127
labels, 58-59
layer blend modes, 274
lookup tables, 69
masking, 100, 112-114
Photoshop settings, 155-156
slider, 84
soft proofing, 313
space, 9
wheels, 122
color space
defined, 9
Elements, 154
how to choose, 152
large and small, 151
Lightroom/Photoshop integration, 150-157
Photoshop settings, 155-156
print profiles, 310
combining photos
group photos, 282-284
HDR images, 284—288
lesson on, 266-295
panoramas, 289-293
Photoshop tools for, 10
review of, 294, 295
texture and collage effects, 269-281
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Comments panel, 34
Compare view, 37
compatibility preferences, 156—157
compositing, 10
Content Authenticity Initiative, 195
Content-Aware Fill, 216-235
Content-Aware Scale, 218-235, 260-261
content credentials, 195
content removal, 209-218
contrast, 72-73
copies, virtual, 88—89
Copy as DNG, 21, 24
Copy/Paste, 20, 91
copyrights, 300, 306
Create Collection, 49
Create Smart Collection, 55
creating collections, 5054
Creative Cloud, 4, 158
creativity
artistic portraits, 241-250
authenticity and, 195
blur effects, 250-258
color effects, 120-127
sharpening, 83
Crop & Straighten, 85
cropping images, 85-86, 223
culling, iterative, 46—49
cursors, resizing, 117
Curves option, 247
customization of view, 35-40

D

dark circles under eyes, 226
deghosting, 286
Dehaze slider, 101, 113, 287
deletions, keyword, 61
depth of field, 250
design elements, 11
destructive editing, 5
detail
adding, 79-80
enhancing, 139
panel, 81
slider, 81, 84
Develop module
adding detail, 80-85
clarity, vibrance, and saturation, 79-80, 125
how to use, 67
profiles, 68-71
saving defaults/presets, 74—75
shadows and highlights, 73-77
slideshow in, 313
syncing changes, 90-92
white balance, 71-72
white/black adjustment, 77-79



digital alteration, 231

The Digital Print (Schewe), 83
Distortion slider, 253

DNG (digital negative), 24
DPI (dots per inch), 153
Dunbar, Dennis, 230
Duplicates, 88

E

eating disorders, 231
edge contrast, 287-288
editing. See also adjustments
Content-Aware Fill/Scale, 218-235
content removal, 209-218
global adjustments, 6785
local adjustments, 94-131
masks for, 97-98
parametric, 97
Photoshop layers for, 5
primary external editor, 151, 153
raw file editing, 159-164
responsibility in, 231
safeguarding original, 209
saving variations during, 88—90
setting Lightroom preferences, 150—155
syncing changes, 90-92
TIFF or JPEG editing, 166—168
Effects panel, 127-129
Eismann, Katrin, 230
Elements, 154, 156, 169
Elliptical Marquee tool, 181
emailing photos, 301-303
Embedded & Sidecar, 29
ethics, 231
exaggerated edge contrast, 287-288
Export command, 303-304
exporting work
books, slideshows, and web galleries, 312-315
emailing photos, 300-303
exporting photos, 303-307
identity plates, 299-300
lesson on, 296-317
presets, 308
prints, 308—-312
review of, 317
signature graphic, 302
watermarks, 300-301
exposure
HDR images, 284—285
setting, 72-73
slider, 99, 103
External Editing preferences, 150—-155
eyes, adjusting, 137-138
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F

f-stops, 72
facial feature manipulations, 234
fades, photo, 272-278
File Handling panel, 23
File Renaming panel, 40
files
naming externally edited, 155
renaming during import, 24—26
Fill command, 11
Filmstrip, 30, 48
filters
adjusting, 101
Blur effects, 250-256
Linear Gradient, 99-102
Radial Gradient, 103—-104
skin texture, 228-229
flag markers, 47
flow, 229, 247
flyaway hairs, 142-143
focal point accentuation, 250-252
folders
creating collections from, 50-52
Library module panel, 32
organizing storage via, 19-20
renaming during import, 24—26
formats
emailing photos, 301
export, 304—-305

Lightroom/Photoshop integration, 151

proprietary vs. open, 24
Forward Warp tool, 232
Free Transform, 222, 275
frequency separation, 139-140
fringing, 192

G

galleries, web, 312-315
global adjustments
cropping, 85-86
Develop module, 64-93
developing pictures, 67—-85
lens corrections, 86—88
lesson on, 64-93
Lightroom, 9
process versions, 92
review of, 93
snapshots for variants, 89-90
syncing changes, 90-92
virtual copies for variants, 88—89
glow, glamour, 241
Glow slider, 241
Gradient Mask, 275-278
grading, color, 122—127



grain, adding, 127, 129
graphic, signature, 302
Grid view, 31, 35

group photos, 282-284
guided transformation, 87

H

Haftel, Josh, 69

Hair
Clone Stamp tool for, 212
selecting, 196-201

halos, edge, 192

hard drives, 26, 315

The HDR Book (Concepcion), 286

HDR (high dynamic range) images
how to make, 284—288
Lightroom editing of, 9
panoramas, 289, 291-293

headless mode, 287

Healing Brush, 209, 212

Heisler, Gregory, 120

Help resources, 14—15

highlights, adjusting, 73-77

histogram, Library module, 33

identity plates, 299-300
importing and managing photos
catalog imports, 20-30
choices for, 20-21
copyright addition during, 27
hard drive, 26-28
lesson on, 16—43
Library management, 30-35
memory card, 21-23
renaming photos, 24—26, 40—41
review of, 42-43
storage, 18—-20
view customization, 35—40
information panels, Library module, 33-35
input sharpening, 81, 83
inspection, spot, 118
Instagram carousel, 259-264
integration, Lightroom/Photoshop, 150-157
Iris Blur filter, 250-252
irises, enhancing, 138—-139
iterative culling, 46—49

J

JPEGs
bit depth for, 153
color space for, 151
exporting, 305
Lightroom to Photoshop sends, 165-168
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saving prints as, 309
vs. raw images, 8, 151

K

keywords
adding, 59-61
panel, 34

Kost, Julieanne, 306

L

labels, adding, 58—59
landscape profile, 70
landscapes, Liquify tool for, 235
Lasso tool, 184—190, 196
layers, Photoshop
blend modes, 274
collages with, 278-281
compositing via, 10
defined, 5
fading photos with, 272-275
layer mask rhyme, 258
masks and, 11, 98
photo combinations and, 269
lens corrections/transformations, 86—-88
lessons
experimentation with, 2
importing files for, 13
importing/managing photos, 16, 18
online files, 3
prerequisites for, 2
Libraries panel, 201
Library module
managing photos in, 30-35
renaming photos in, 40—41
slideshow in, 313
syncing changes in, 92
view customization, 35-38
license image, 201
light exposure, 72
Lightroom Classic
benefits of, 7-10
catalog creation, 12—13
CIB lessons for, 1-2
HDR image-making, 284287
importing/managing photos, 16-43
installing, 4
integration with Photoshop, 4-12, 150-157
new profiles in, 68-71
new tools, 97, 109-111, 121
organization via, 5-6
panoramas, 289-290
process versions, 92
role of, 4
sending JPEG and TIFF to Photoshop, 165-168



Lightroom Classic (continued)
sending photos to Photoshop, 159-165
sending Smart Objects from, 169-173
snapshots, 169-173
synced with Camera Raw, 157—-158
vs. Photoshop, 4-7
Windows vs. macOS, 2

Lights Out mode, 36

Linear Gradient tool, 99-102

Liquify tool, 226, 230-235

local adjustments
adding/subtracting masks, 114-115
Clarity and Dehaze slider, 113
color effects, 120-127
color masking, 112114
Effects panel, 127-129
existing mask add-ons, 104-105
lesson on, 94
Lightroom, 9
Linear Gradient tool, 99-102
Masking Brush tool, 106
object removal, 116-119
Radial Gradient tool, 103—-104
review of, 130-131
second mask add-ons, 107-108
Select Sky/Select Subject, 109-111
syncing, 91
via masks, 97-98

Loupe view, 37

Luminance, 83

LUTs (color lookup tables), 69

M

macOS instructions, 2
make public, 57

management. see importing and managing photos

Marquee tools, 180-190, 202
Masking Brush tool
fading photos with, 272-275
how to use, 106
Opacity vs. Flow, 229
operating system and, 198
secondary masks, 107
skin softening with, 139-141
masks. See also selections
adding second, 107-108
adding/subtracting, 114-115
adding to existing, 104—105
brush-based, 106-108
Color and Luminance Range, 112-114
color of, 100
fading photos with, 272-278
layer mask rhyme, 258
Masking Brush tool, 106
Photoshop layers as, 11

INDEX

pixel- and vector-based, 97-98
Select And Mask workspace, 196-201
Select Sky/Subject, 109-111
sharpening and, 82
tightening, 192
visibility of, 106

Masks panel, 98

matting, 192

Maximize Compatibility preferences, 156—157

maximum print size, 312
memory cards

erasing, 21

failure of, 25

imports from, 21-24
merging to HDR, 285-286
merging to panorama, 289-290
metadata

copyrights, 27

exports and, 306

keywords, 59-61

Library module panel, 34

star and color ratings, 58—59
Minimal option, 29
misinformation, 195
Mixer brush, 244, 245-248
Monochrome profile, 69
motion, with blur effects, 254-258
move, 21
multiple focal points, 250
multiple photo processing, 9

N

NAS (network-attached storage drive), 18
negative clarity, 113

nested keywords, 60

neural filter, 230

neutral profile, 70

noise reduction, 83, 84, 165
nondestructive editing, 6

o)

object removal, 116-119
Object Selection tool, 193-195
Qil Paint filter, 244245
1:1 option, 29
online content, 3-4, 14
online sharing, 57-58
Opacity, 229, 247, 270
open formats, 24
operating system tips, 2
organization
collections, 49-58
iterative culling, 46—49
keyword additions, 59-61
lesson on, 44-63



Lightroom, 4, 5-6 pixel-based masks, 98

review of, 62—63 pixel editing, 5
sets, 54—55 PNG format, 305, 309
star ratings and labels, 58—-59 Polygonal Lasso tool, 184—190
temporary, 56 pore detail, 226
via collections, 33 portrait profile, 70
organizational sets, 54—55 portraits
output sharpening, 83 artistic treatments, 241-250
body sculpting, 230-235
P enhancing irises, 138—139
flyaway hair removal, 142-143
painting, from photo to, 244-245 lesson on, 132-147
Palmer, Wayne, 230 lightening teeth, 135137

panels, Library module, 30-35 lightening whites of eyes, 137—-138

panoramas Photoshop corrections, 201-203
creating HDR, 291-293 reducing wrinkles, 143-144

o o ks 395950 ooty
) - review of, 147
parametric editing, 97 skin softening, 139-141, 231
Patch tool, 214-216 post-crop vignetting, 103, 127-129, 164

Path Blur, 255

Pen tool selections, 184
perspective corrections, 86—87, 253
Pew Research, 195

ppi (pixels per inch), 153
prerequisites, 2
presets

exporting multiple, 308

Photoshop exporting photos and, 306-307
artistic portrait treatments, 241-250 identity plates, 299—300
benefits of, 10-12 Lightroom, 9
Classroor‘n in a Book lessons for, 1-2 Lightroom/Photoshop integration, 150-155
color settings, 155-156 Photoshop color settings, 155-156

combining photos with, 269-281
Content Authenticity Initiative, 195 saving Develop module, 7475
Content-Aware Fill/Scale, 218-235, 260 tool settings, 102

content removal, 209-218 watermarks, 300301

creative blur effects, 250-258

saving, 74-75

2 . previews

editing via, 5 enlarging, 36

hair and soft edge selections, 196-201 options, 29

HDR image-making, 287-288 selecting thumbnail, 39
identity plates, 300 Print module, 308
installing, 4 prints

integration with Lightroom, 4-12, 150-157 creating, 308—312
photo finishing in, 106 Lightroom, 10

Select Object, 193—-195
Select‘ Sul?ject, 190-192 process version, 92
selection in, 178-190, 201-203 Process Version 5, 92
sending JPEG and TIFF to, 165-168 Profile Browser, 70

resolution for, 153

sending photos to Lightroom, 159-165 profiles

skin/body retouching, 225-230 camera, 68—71
sky replacement, 259-260 lens, 86

Smart Objects sent to, 169-173 print, 310

snapshots, 169-173 promotion, self, 259
speCIIallzed tasks in, 4 ProPhoto RGB, 151, 152
vs. Lightroom, 4-7 proprietary formats, 24
' Windows vs. macOS, 2 publish services
pixels Lightroom, 10

blending, 209 online sharing, 57
export format and, 305 overview of, 33

maximum print size, 312
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Q Select And Mask workspace, 196-201
Select Object, 193—-195

Select photo, 37, 39

Select Sky, 97, 109-111

Quick Collection, 56
Quick Develop panel, 34, 51

Select Subject
R Al advances in, 97
Radial Blur filter, 254—256 Lightroom tool, 109-111
Radial Gradient tool, 103—104 Photoshop tool, 190-192
Radius slider, 81 portrait correction with, 203
rating images, 58—59 vs. Object Selection, 197
raw images selections. See also masks
bit depth for, 153 additions/subtractions, 187-190
color space for, 151 hair and soft edge, 196201
HDR images, 284 Photoshop basics, 179-180
Lightroom to Photoshop sends, 159-165 Polygonal Lasso tool, 184-190
processing, 7 portrait corrections, 201-203
proprietary vs. open, 24 Rectangular Marquee tool, 180—184
Smart Objects, 169 tightening, 192
syncing Lightroom and Camera Raw, 157-158 selective adjustments. See local adjustments
vs. JPEG, 8 sensor spot removal, 116-118
Rectangular Marquee tool, 180—184, 202 sets, collection, 52-54
registration, book, 3 setting the sample point, 209
relative adjustments, 34 Shadows
removal of objects adjusting, 73-77
Lightroom, 116-119 clipping, 73
Photoshop, 209-218 shape, selection by, 180—-190
repositioning and, 11 sharing collections, 57-58
sky replacement, 259-260 sharpening, 81, 83, 84-85, 165
renaming signature graphic, 302
exports and, 304 sketch, from photo to, 248-250
imports and, 24—26, 4041 skin softening, 139-141, 225-230
memory card failure and, 25 sky
rendering with Lightroom, 158 replacing, 259-260
resizing photos, 305-306 selecting, 97, 109-111
resolution, 153, 305, 312 Slice tool, 261-264
responsibility for authentic content, 231 sliders, resetting, 99
result color, 274 slideshows, 312-315
retouching smart collections, 55-56
Content-Aware Fill/Scale, 218-235 Smart Objects
content removal, 209-218 Adobe Elements and, 169
ethics and, 231 new Photoshop tool, 5
lesson on, 206-237 sent from Lightroom to Photoshop, 169-173
Photoshop tools for, 11 snapshots, 169-173
review of, 236, 237 smoothing skin, 226-227
skin, 225-230 Smoothness slider, 84
video demos, 228 snapshots

Elements and, 169
Lightroom/Photoshop work with, 169-173

S used for variations, 89-90
sample point setting, 209 social media, 259, 309
sampling brush, 220, 221 soft brush, 272-275
Saturation, 79-80 soft glow, 241

scaling up, 222-225 soft proofing, 151, 313
Schewe, Jeff, 83 softening, 113

sculpting portraits, 230-235 Solo mode, 36-37

secondary masks, 107-108 Source panels, 31
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special effects Tone control, 51

artistic portrait treatments, 241-250 tones
creative blur effects, 250-258 adjusting, 80
Instagram carousel, 259-264 dark and light, 73
lesson on, 238-265 mapping, 286
Photoshop, 11 soft proofing, 313
review of, 265 toolbar, Library module, 37
Spot Healing brush, 209 transformations
Spot Removal tool lens, 86—88
distraction removal with, 116-119 Photoshop selections, 180—-190

flyaway hair removal, 142-143
Healing and Cloning settings, 9
sRGB, 152, 305 \Y
stacks, 154
standard option, 29
star ratings, adding, 58—-59
stock images, 201

variations, image, 88—90
vector-based masks, 98
Vibrance, 79-80

video demos, 228, 311

storage .
collection locations, 50 video storage, 19
tips for, 18-20 view, customizing, 35—40

straight-edged selections, 184187 Vignetting, post-crop, 103, 127-129, 164

virtual copies, 88—89, 123

stylizing portraits, 241-250
Visualize Spots, 117

subject. See also Select Subject

adding motion to, 256-258 Vivid profile, 70
group photo, 282
Select Subject in Lightroom, 109-111 w

Select Subject in Photoshop, 190-192
subtracting masks, 114115
support resources, 14

watermarks, 300-301
web edition, 3

. web galleries, 312-315
Survey view, 37 Wendt, Max, 139-140
syncing changes, 90-92 white balance, 71-72
syncing collections, 57-58 Whites, adjusting, 7779
whites of eyes, 137-138

T Windows instructions, 2
target collection, 5657 Workﬂow ‘
Targeted Adjustment tool (TAT), 121 iterative culling, 46
teeth, lightening, 135-137 Lightroom, 4
text workflow, Lightroom-Photoshop round trip
adding, for exports, 309 lesson on, 148-175
mode, 48 Lightroom/Camera Raw syncing, 157-158
Photoshop tools for, 11 program integration, 150-157
texture raw file sending, 159-165
brush, 139-141 review of, 174—175
combining photos for, 269-281 sending Smart Objects, 169-173
slider, 140 wrinkles, reducing, 143-144, 226
thumbnails

Develop tools for, 51-52

selecting, 39

size adjustment, 22, 36

stacks of, 154

storage space for, 13
TIFF

file size, 151

Lightroom to Photoshop sends, 165-168
Tilt-Shift filter, 252254
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